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Preface
Welcome to the Caffeine Software TIFFany3 Tutorials

These tutorials provide examples and instructions for using 
TIFFany3 features and for specific ways to enhance your images. 
In some cases, there are various ways to use TIFFany3 to 
perform the same operation. These tutorials present the standard 
or suggested procedures, which usually provide the best results.

• Chapter 1 - General tutorials for learning TIFFany3 features 
and functionality. You get the most value out of the general 
tutorials if you go through them sequentially. The tutorials 
build upon features and instructions that are presented in 
previous tutorials. 

• Chapter 2 - Tutorials for specific tasks. These tutorials 
include concepts from the general tutorials and assume that 
you have already completed the general tutorials.

• Chapter 3 - Advanced tutorials. Many of the described 
features are available only in the Professional version of 
TIFFany3.

Image documents are provided for the tutorials that describe 
working with specific documents. You can use these provided 
documents to follow along in TIFFany3. The Actions used in 
these tutorials are all preconfigured in both the Basic and 
Professional versions of TIFFany3 unless specified otherwise.

The Caffeine Software TIFFany3 Tutorials also assumes that you 
have working knowledge of Mac OS X and does not describe 
functionality and features related to the operating system. For 
example, it is expected that you know how to customize toolbars 
for windows when you come across descriptions for toolbar 
items that are currently not displayed. The tutorials also assume 
that you are familiar with general digital image concepts such as 
pixels and RGB values.
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Other Resources

The Caffeine Software website at http://www.caffeineSoft.com 
always provides the latest version of the tutorials in PDF. Aside 
from the Caffeine Software TIFFany3 Tutorials, you can find 
additional information about TIFFany3 on the Caffeine Software 
website, including:

• User Guide - The Caffeine Software TIFFany3 User Guide 
explains the core concepts and features of the TIFFany3 
image processing application and describes how to use 
TIFFany3 to enhance your digital images. Use Caffeine 
Software TIFFany3 User Guide as both a means to learn the 
application and as a reference while you work.

• List of Features - The list of features provides a summary of 
the key features found in the Basic and Professional versions 
of TIFFany3. 

Support and Contact

Caffeine Software values quality support and is always available 
for your questions and comments.

2051 Rutledge Place
Santa Clara, CA 95051

info@caffeineSoft.com
http://www.caffeineSoft.com

Fax: 408-249-2989
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Chapter

1 General Tutorials
This chapter provides tutorials for key TIFFany3 features and 
functionality.
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Selecting and Organizing Items in the Action 
Catalogue

The Action Catalogue stores Actions and other items that you 
use in your work with documents. The default Action Catalogue 
that comes with TIFFany3 contains a collection of preconfigured 
Actions that you can apply to your image documents. The 
Professional version includes more available Actions than the 
Basic version of TIFFany3.

Items are hierarchically organized in the Action Catalogue, as 
shown by the browser. To the left of the browser columns is the 
Shelf. You can use the Shelf to display shortcuts of frequently 
used items. When you select an item in the Shelf, the Action 
Catalogue browser correspondingly displays and selects that 
item. 

You can also organize your Action Catalogue by creating new 
folders and moving items into another folder using the Shelf. 
This tutorial provides an example of how to find and select items 
in the browser, how to place, remove, and organize items in the 
Shelf, and how to use the Shelf to organize the Action Catalogue.

Note Even though the Action Catalogue primarily contains Actions, you can 
also store Engines and marquees and select and organize them the way 
you do for Actions.

Finding and Selecting Items

Before you can do anything with any item in the Action 
Catalogue, you must first select it. You can navigate through the 
Action Catalogue browser or use the Find Object Name window 
to find and select items, for example the Blue Action, which 
applies blue to the image.
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Action Catalogue Browser

1. Select the Paint folder in the leftmost browser column, which 
is the top level of organization.

2. Select the subfolder Colors.

Any item with an arrow after its name is a folder that can 
contain additional items. 

Note Above the browser is the name and icon of the currently selected item. 
This draggable icon represents the item. You will see the same icon in 
other parts of the application.

3. Select the Blue Action. 

Any item without an arrow after its name is an object that 
does not contain more items. 
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Note The rest of the tutorials display the preconfigured Action Catalogue 
navigation paths in the format: Paint > Colors > Blue. 

Find Object Name Window

1. Open the Find Object Name Window by clicking Search in 
the Action Catalogue toolbar, pressing Command+Shift+F, or 
using the Controls menu (Controls > Action Catalogue > 
Find in...). 

2. Enter Blue.

3. Press the Find button until the correct item is selected in the 
Action Catalogue browser.

Placing, Removing, and Organizing Items Within the Shelf

1. Select the Sharp 75% Action (Sharp > Sharp 75%). 

2. Drag the icon of the Action to the Shelf, located left of the 
browser.

You are placing a shortcut to the Action on the Shelf. The 
Action exists in its original place in the browser, even if you 
remove its icon from the Shelf. 

3. To remove the Sharpen Action from the Shelf, drag its icon 
out of the Action Catalogue. 
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4. To organize the Shelf, drag the icons to rearrange the items.

Organizing Items

1. Click New Folder in the toolbar of the Action Catalogue. An 
untitled folder appears in the folder that is currently selected 
in the browser, Alpha Channel.

2. Enter Contrast for the folder name in the field next to the 
folder icon and press Return.

3. Drag the folder icon to the Shelf. You are placing a shortcut to 
the folder on the Shelf. The folder exists in its original place 
in the browser. 
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4. Select all Contrast Actions (Brightness > Contrast). A 
multiple item icon appears whenever more than one item is 
selected. Drag this icon into the Contrast folder icon in the 
Shelf. 

Tip To select multiple items, you can Shift-click or drag up or down in a 
browser column.

These Actions now exist within the Contrast folder.

5. You realize that the Contrast folder should be moved from 
the Alpha Channel folder to the Brightness folder. Select the 
Brightness folder and drag its folder icon to the Shelf.

6. In the Shelf, drag the Contrast folder icon into the Brightness 
folder icon.

The new folder, Contrast, along with its Contrast Actions, now 
exist in the Brightness folder.

Multiple Item Icon
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Note You can organize the items in the Action Catalogue any way you like. 
The rest of the tutorials, however, show the original navigation paths to 
Actions, for example, the path to the Contrast +10% Action would be 
Brightness > Contrast +10%. 
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Getting to Know the Document
TIFFany3 can open various different types of image files and 
also provides a TIFFany3 document type. A document consists 
of at least one layer, which contains pixels that make up your 
image, and any marquees that you create. You use marquees to 
select parts of the layer that you want to modify.

These tutorials introduce you to the document window and 
show you how to create marquees, select items, and so on.

Familiarizing Yourself with the Document Window

A document window contains not only your document but also 
tools that you can use with your image. This tutorial introduces 
you to the various tools along the bottom right corner of the 
document window.

1. Open Waterfall.jpg. This document has one layer, which is 
the image that you see in the document window.

2. Click and hold on the first tool along the right side of the 
document window.
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You see the tools that you can use to manually create 
different types of marquees. You will learn how to use these 
tools in Manually Creating Marquees on page 11.

3. Click and hold on the second tool down.

You see the Arrow, Rotate, and Hand (scroll) tool.

• Arrow tool - Select and move items in your document.

• Rotate tool - Rotate layers or marquees.

• Hand tool - Navigate around in your document instead of 
using scroll bars. 

You will learn how to use the Arrow and Rotate tool in 
Manually Selecting and Manipulating Items in the Document 
on page 15.

4. Drag the notch in the bottom right corner of the document 
window inwards to make the window smaller so that both 
scroll bars appear. 

5. Select the Hand tool. The cursor will still look like an arrow.

6. Click in the Waterfall.jpg layer, and drag in different 
directions. Notice how both scroll bars move according to 
your movements with the Hand tool.

7. Next is the Magic Wand tool, which you use to automatically 
create a bitmap marquee. You will learn how to use this tool 
in Using the Magic Wand on page 34.

8. Next is the Crop tool, which you use to manually crop layers. 
You simply drag a box specifying the area that you want to 
crop and click the Crop It! button that appears.
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9. Select the next tool, Zoom, and click to zoom in on a specific 
part of the document.

10. Next is the Brush tool, which you use manually apply 
Actions to your document. You will learn how to use this tool 
in Applying Actions on page 22.

11. To the bottom left of the Brush tool is the Brush Size popup, 
which you use to change the size of the brush tip. You will 
also learn about this tool in Applying Actions on page 22.

12. To the left of the Brush Size popup is the Zoom poplist, 
which you can use to change the zoom of the document view, 
for example from 100% back to 50%.

13. Next is the Interpolation Display tool, which you use to 
toggle between viewing the document with or without 
interpolation. Interpolation smooths the display of pixels in 
the document window but does not affect the actual layers.

You simply click on the Interpolation Display tool, which 
shows a jagged edge for a view without interpolation and a 
smooth edge for a view with interpolation.

Without Interpolation With Interpolation
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Note For purposes of optimizing processing speed and working with the 
image, you generally view your document without interpolation.

14. Next is the Stop Action button, which shows you when a 
process such as an Action application is running on your 
document and lets you manually stop the process. You will 
learn how to use this button in Applying Actions on page 22.

15. Next is the Font Panel button, which you click to bring up the 
font panel that you use with text marquees. You will learn 
about the font panel in Adding Text to the Image on page 99.

16. Finally is Color Palette button that you click to bring up the 
color palette. You can use the color palette to select colors to 
use with certain Actions, for example Paint and Shaded 
Color. You will learn about the color palette in Using the 
Magic Wand on page 34.

Manually Creating Marquees

Use the marquee tools mentioned above to manually create 
marquees that you use to select parts of the layer that you want 
to modify. This tutorial shows you how to create marquees of 
different types and shapes.

1. Open Letter-R.tiff.
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2. Select either the Rectangular or Elliptical Marquee tool.

3. Click in the document and drag in one direction to draw the 
marquee.
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4. When you release the mouse button, the marquee is created 
with selection handles.

You create the Star/Polygon marquee in the same way but 
follow additional steps to determine if the marquee is a star, 
polygon, or triangle. You will learn this in Using the Marquee 
Inspector on page 49.

5. Press Command+Z or Delete to remove the marquee that you 
just created.

Note Pressing Delete removes the currently selected item in the document, 
in this case the marquee. If the document contains only one layer and 
no marquees, Delete does not remove the final layer.
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6. Select the Freehand Marquee tool, click and drag to manually 
draw the marquee.

7. Delete the freehand marquee and select the Bézier Marquee 
tool.
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8. Click on points in your document and a marquee is created 
as TIFFany3 sequentially connects the points with a straight 
marquee border.

You use the Text Marquee tool mainly to add text to your 
document. You will learn how to create text marquees in 
Adding Text to the Image on page 99.

Manually Selecting and Manipulating Items in the Document

Use the Arrow tool to manually select items, either layers or 
marquees, in your document. Usually you need to select an item 
in order to do something to it, for example rotate. If you have 
more than one layer in your document, it is especially important 
which layer is selected because Actions are applied only to the 
selected, or main, layer.

You also use the Arrow tool to manually move or resize the 
selected item. Use the Rotate tool to manually rotate the selected 
item. 

This tutorial shows you how to manually select and manipulate 
items in your document.

1. Open Letter-R.tiff.
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2. Manually create a marquee of any type that encompasses 
both opaque and transparent areas of the layer.

3. Use the Zoom poplist to change the view to 75%.
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4. Click on the letter R outside the marquee to select the layer. 
Selection handles appear for the selected item, in this case the 
layer.

Tip To select a layer, always click on an opaque pixel. If there was a 
completely opaque layer below the letter R, if you click on a transparent 
pixel in the letter R layer, the other layer is selected.
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5. With still the Arrow tool, click within the layer and drag to 
move the layer. You move marquees the same way.
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6. Click anywhere within the marquee to select it.

Note It does not matter if you click on an opaque or transparent pixel within 
the marquee. When you click anywhere within a marquee, the marquee 
is always selected instead of the layer.
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7. Click and drag on a selection handle to manually resize the 
selected item, in this case the marquee. You can do the same 
with layers.

8. Select the Rotate tool. Your cursor will still look like an arrow.
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9. Click on a selection handle and drag in the direction that you 
want to rotate the selected marquee. You can do the same 
with layers.
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Applying Actions
The Actions that you apply modifies your image documents in 
specific ways. You can automatically apply an Action or use the 
brush to manually apply the Action. This tutorial provides an 
example of using both methods to apply Actions.

1. Open Chipmunk.jpg.

2. Select the Contrast +20% Action (Brightness > Contrast 
+20%).

3. Click Detail in the toolbar of the Action Catalogue and select 
Preview from the poplist. The preview box flashes with the 
before and after application image and then settles into a 
preview of the image with the Action applied.

Tip The preview box demonstrates what the Action does even if you do not 
have a document open. Even though the preview is a good way to learn 
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about each preconfigured Action, the preview does not apply to some 
Actions that cannot be demonstrated.

4. To automatically apply the Action, you can either click Apply 
in the toolbar or drag the Action icon into the image 
document.

The Stop Action button is active when the Action is being 
applied. You can press the activated button to stop the 
application. The inactivated button signifies that the Action 
application is finished.

5. Select the Sharp 75% Action (Sharp > Sharp 75%).

6. Select the Brush tool. You can set the brush size with the 
Brush Size popup.
Applying Actions     23



7. Manually apply the Action by brushing over the areas that 
you want to sharpen. For more precision, use the Zoom tool 
to the left of the Brush Size poplist to increase the document 
view.

8. You can even manually undo the previous Action. Select the 
Undo 1 Action (Paint > Undo 1), decrease the brush size for 
precision, and brush over parts of the image that you want to 
unsharpen. 
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Working with Multiple Layers
Image documents in TIFFany3 can consist of not only multiple 
layers but layers of different color space, resolution, and size. 
This tutorial provides an example of working with layers and 
marquees to apply Actions to your image.

1. Open PigeonPointLighthouse.jpg and Letter-R.tiff.

2. Move Letter-R.tiff into the other document, either by 
dragging the image into the other window or copying and 
pasting.
Working with Multiple Layers     25



3. With the letter R layer still selected, use the Rotate tool to 
rotate the layer.

4. Select and apply the Twirl 45 Action (Geometry > Twirl 45). 

Note Twirl 45 is available only in the Professional version of TIFFany3. If 
you have the Basic version, select another Action to use.

The Action is applied only to the main, selected layer, the one 
with a border, either with or without handles. 
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5. Create a rectangular marquee that covers areas of both layers.

6. Use the Arrow tool to select the other layer as the main layer. 
Select and apply the Rainbow Action (Gradient > Rainbow). 
Only the areas of the main layer that the marquee offsets are 
affected. 
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7. Press the Tab key to hide all selections. The marquee and 
layer borders disappear. 

8. Select and apply the Spotlight Action (Effect > Spotlight). The 
hidden marquee has no effect, but even though the layer 
border is also hidden, the Action still applies only to the main 
layer.
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Combining Layers

A TIFFany3 document can have multiple layers. Actions and 
other functions apply to only the main, or selected layer. In some 
cases, you want to combine multiple layers into one layer. This 
tutorial provides an example of creating a document with 
multiple layers and combining layers into one.

1. Open PescaderoRock.jpg and Letter-R.tiff.

2. Drag Letter-R.tiff into the other document or use copy and 
paste.

Note The transported layer appears at its original position in the new 
window unless that would take it out of the document window view. In 
that case, the layer appears in the middle of the document window. 
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3. Move and resize the added layer as you desire.

4. To add another Letter-R layer to the same document, you can 
copy and paste within the document window or select 
Duplicate from the Layers menu. Move and resize the new 
layer as you desire.

5. To combine only two of the layers, you must hide the third. 
Open the Components Inspector by pressing Command+1. 
You can also select Inspector... from the Controls menu and 
then select Components from the poplist in the Inspector.
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6. Click on the check mark next to the layer that you want to 
hide. The X signifies a hidden item.

7. Select Flatten from the Tools menu. In general you want to 
keep the Use highest DPI check box checked and use the 
default DPI. Click Apply in the toolbar.

Note No matter which layer is selected, all active or visible layers are 
combined into one layer.
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8. Unhide the other layer in the Components Inspector. To bring 
that layer in front of the combined layer, select the layer in 
the Inspector and drag the image representation above the 
combined layer.

9. Select the combined layer in the document window.

10. Select and apply the Abdou 05 Action (Edge > Abdou 05). 
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Note Abdou 05 is available only in the Professional version of TIFFany3. If 
you have the Basic version, select another Action to use.

The Action is applied only to the main layer, the combined one. 
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Using Bitmap Marquees
So far, you have manually created marquees of specific size and 
shape that you determine. You can also use the Magic Wand to 
isolate parts of your image based on color, saturation, shape, 
brightness, or any combination thereof. Mask Actions are also 
available for creating bitmap marquees, which are automatically 
generated marquees based on your given criteria.

Using the Magic Wand

Use the Magic Wand tool to create bitmap marquees that offset 
areas depending on settings that you control. For example, you 
can create a marquee for the areas of the image that are 
particularly dark and apply a Brightness Action to only those 
areas. You must use the Magic Wand Inspector to define the 
tolerance settings your selection. For example, with a narrow 
brightness tolerance, the tool selects only areas that are similar in 
brightness to the point that you click on the image with the 
Magic Wand tool.

This tutorial provides an example of using the Magic Wand tool 
to change the color of an object in your image.

1. Open Car.jpg.

2. Open the Magic Wand inspector by pressing Command+5. 
You can also select Inspector... from the Controls menu and 
then select Magic Wand from the poplist in the Inspector.

3. To select the red parts of this image, you want to set a 
relatively narrow tolerance for the Hue setting. The left 
control is the percentage of absolute tolerance. For example, 
set the value to 10 so that when you click with the Magic 
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Wand tool on your image, the resulting marquee includes 
only pixels with a hue that is within 10% deviance from your 
click point. 

The right control is the percentage of absolute intolerance, 
and any percentage you leave between the two extremes is 
the relative tolerance. For example, set the absolute 
intolerance at 10 also so that there is no gradient of tolerance.

In this case, the other settings are not applicable to your goal, 
so you can set the Saturation and Brightness controls at 100 
and Alpha at 0.

Note For more complex marquees, or to fine tune your Magic Wand 
tolerance, you might use more than one setting in the Magic Wand 
inspector. Experimenting with the settings will help you understand 
how to take the most advantage of the powerful Magic Wand tool.

4. Select the Magic Wand tool and click on the red car. A bitmap 
marquee is created accordingly to your tolerance settings.
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Note If you do not get the marquee that you want, delete the marquee and 
click on another point in the layer.

5. If you change the setting so that the absolute tolerance is 20 
and absolute intolerance is 30, you can see that more areas 
are selected because the tolerance is larger.

6. With the settings back at 10, select the Shaded Color Action 
(Paint > Shaded Color) and open the Color Palette by using 
the Controls menu, pressing Shift+Command+C, or pressing 
the Color Palette button in the document window. Select the 
color that you want to apply.

7. Apply the Action, and you now have a car with the new 
color.

8. If the marquee included areas that you did not want to be 
blue, you can use the Undo 1 Action (Paint > Undo 1) to 
manually remove the Shaded Color Action.
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Tip Press Tab to hide this marquee. Tab hides and displays all marquees in a 
document.

For example, you can undo the blue behind the front wheel.
Using Bitmap Marquees     37



You can also clean up the turn signal.
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9. In this case, the Magic Wand did not pick up the left rear 
view mirror because it is not connected with the rest of the 
red areas in the image. With the same Magic Wand settings, 
create a marquee.

10. Apply the same Shaded Color Action.
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Your final result is a car with a realistic new color.

Using Mask Actions

Mask Actions create marquees for your document instead of 
directly modifying the image. For example, the Select Red 
Action masks the red areas of the image. You can then apply an 
Action that affects only those red sections. 

Before you apply a Mask Action, try adjusting the Action 
settings to fine tune the resulting marquee.

This tutorial provides an example of using a Mask Action to 
enhance your document.

1. Open Stockholm.tiff.
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You want to apply the Rainbow Action to the sky but not the 
rest of the image. Note that the shadowed areas run across 
the horizon. 

2. Select the Shadows Action (Mask > Brightness > Shadows). 
The Preview box shows the resulting marquee in bright 
green.

3. Click Create Mask in the Action Catalogue toolbar.

4. Open the Marquee Inspector by pressing Command+3. You 
can also select Inspector... from the Controls menu and then 
select Marquee from the poplist in the Inspector.
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5. Select the Difference Type option so that Actions are applied 
to areas outside of the marquee. Notice that the dotted 
marquee border now moves clockwise in the Difference 
mode instead of counter-clockwise in the default Union 
mode. 

6. Select and apply the Rainbow Action (Gradient > Rainbow).

Because of the Mask Action and the inverted bitmap 
marquee, the Action is applied only to the sky.
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Your final result is a picture with a rainbow in the sky.
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Working with Multiple Marquees
This tutorial provides an example of working with multiple 
marquees to apply Actions. 

1. Open Letter-R.tiff.

2. Select the Elliptical Marquee tool and create an oval marquee 
on your image.
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3. Select and apply the Sun Spider Action (Texture > 
Mandelbrot > Sun Spider). The Action is applied only to the 
area that the marquee offsets. 

Note To create another marquee without removing the current one, either 
hold down the Shift key when you create the marquee or uncheck the 
Drag replaces Marquee check box in the Mouse Action preferences.
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4. Select the Freehand Marquee tool and create another 
marquee.

5. Select the Blur Horizontal 09 Action (Effect > Blur Horizontal 
09) and brush over parts of the document that you want to 
blur. Only the areas within the marquees are affected, and the 
marquee prevents you from brushing out of bounds.
46     Caffeine Software TIFFany3 Tutorials



6. Press the Tab key to hide the marquees. 

7. Select and apply the Heat Scale Action (Color Map > Heat 
Scale). The hidden marquees do not affect the Action 
application.
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8. Press the Tab key to bring back the marquees. Use the Arrow 
tool to select the freehand marquee and press the Delete key 
to remove it. 

9. Select the Fisheye Action (Geometry > Fisheye) and click the 
Apply icon.

The resulting image is an example of how you can use marquees 
along with Actions to enhance your documents.
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Using the Marquee Inspector

With the Marquee Inspector, you can control various settings for 
your marquees. Some settings apply to all marquees, others to 
only one type. You can use the Marquee Inspector with multiple 
marquees, including the bitmap marquees created by the Magic 
Wand tool and Mask Actions.

This tutorial provides an example of using the Marquee 
Inspector with your marquees to apply Actions to an image.

1. Open rose.jpg.

2. Create a rectangular marquee that frames the image.
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3. Open the Marquee Inspector by pressing Command+3. You 
can also select Inspector... from the Controls menu and then 
select Marquee from the poplist in the Inspector.

4. In the Marquee Inspector, move the Corner Rounding slider 
to curve the corners of the marquee. 

5. To apply an Action along the border of the marquee, select 
the Outline setting for Area option and notice that the 
Outline slider becomes active. Adjust the slider for the 
thickness of the outline. You can adjust the Smooth slider to 
blur both edges of the outline.

6. Select and apply the Ocean Rays Action (Texture > 
Mandelbrot > Ocean Rays). Note that the inner and outer 
edges of the outline are smoothed according to the Smooth 
slider setting.
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7. Delete the rectangular marquee, which you do not need 
anymore. 

8. Use the Magic Wand tool to add a bitmap marquee that 
offsets the red areas of the rose.

9. In the Marquee Inspector, set the Intensity slider to 97.

10. Select and apply a blue Shaded Color Action (Paint > Shaded 
Color). Because of the 97% intensity, the Action is applied 
with some transparency so that the combined color of the 
original red and the new blue creates a purple hue.

11. Add a star marquee to the document. Use the Marquee 
Inspector to precisely set its dimensions and location. You 
can always press the Reset button to revert the marquee to its 
original form.

The Star Points slider specifies the total number of angles on 
the marquee. For example, a regular star has five tips, or 
outer points, and five inner points. The Inner Radius slider 
signifies the proportion of the inner points to the outer 
points, for example, 0.5 for the inner points to be halfway 
between the center of the marquee and the outer points. 

12. Set the Inner Radius to 1 and Star Points to 3. You now get a 
triangular marquee.

With the Inner Radius set to 1, five star points creates a 
pentagon, six points create a hexagon, and so on.

13. Use the Marquee Inspector to change the marquee back to a 
star.

14. Additional marquees are always created with the settings of 
the previous marquee, so change the Area setting to Solid 
Area and the Smooth slider to 0.

15. Select the bitmap marquee and, in the Marquee Inspector, set 
the Type option to Difference for Actions to be applied to 
areas within other marquees except any area isolated by the 
bitmap marquee. The Marquee Inspector displays settings for 
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the selected marquee if more than one is visible on your 
document. Note that the Area option is not available for 
bitmap marquees.

16. Select and apply a Plain Color Action (Paint > Plain Color). 
Remember that the bitmap marquee is set at 97% intensity 
with the Difference setting and the star marquee at 100% 
intensity with the Union setting. This means that the Action 
is applied to areas completely outside the bitmap marquee 
but within the star marquee at 100%, but to areas that overlap 
both marquees at 3%. If the bitmap marquee intensity was set 
at 100%, the Action would not affect the overlapping areas at 
all. 

17. Set the Type option for the bitmap marquee to Intersection.
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18. Select and apply another Plain Color Action. Now only the 
areas that overlap both marquees are affected because of the 
Intersection setting, and the Action is applied at 97%. If the 
star marquee was the one set to Difference with the 
Intersection setting, the Action would be applied at 100%. 

19. Set the Type option for the bitmap marquee to Union.

20. Select and apply the Make Button Action. 

Note Make Button is available only in the Professional version of TIFFany3. 
If you have the Basic version, select another Action to use.

With the marquees set to Union, the Action is applied at 
100% to the star marquee, including the overlapping sections, 
and 97% to the bitmap marquee. The higher percentage takes 
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precedence in the overlapping areas when both marquees are 
set to Union.

In this example, the difference between the intensity percentages 
of the two marquees is so small that it does not really matter. 
Experiment with a larger percentage difference to get a better 
sense of how you can use the feature to your advantage.

Experiment also with the Type settings, especially if you have 
overlapping marquees. The binary settings are logical. For 
example, if one marquee is set to Difference and the other to 
Intersection, Difference overrides Intersection because 
Difference means that nothing happens to that marquee. 

Keep in mind which setting each marquee has and how that 
would interact with other marquees. Remember also that it does 
not matter which marquee is selected, because all active 
marquees affect Action application.
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Contrast Enhancement
Use the Contrast Actions to enhance the contrast in your image. 
For best results, first apply an automatic correction and then 
further adjust the contrast until the image looks the way you 
want. 

1. Open SleepyKoala.jpg.

2. Apply the Auto Contrast 1-1 Action (Brightness > Auto 
Contrast 1-1). This Action increases contrast until at least one 
percent of the image are shadows and one percent are 
highlights. In most cases, this Action creates a satisfactory 
contrast balance.
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3. Apply one or more Actions to adjust the contrast as you 
desire. For example, apply the Contrast -20% Action 
(Brightness > Contrast -20%) if you want less contrast.
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Saturation Enhancement
Use the Saturation Actions to enhance the color saturation of 
your image. For example, you can increase the saturation of a 
picture that has a pale, washed-out appearance. The result is an 
image with richer and bolder colors.

1. Open WaterFlowers.jpg.

2. Select and apply the Saturation +20% Action (Color Balance 
> Saturation +20%).
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3. For final adjustments, open and adjust the Action settings. 

4. Click Apply in the toolbar of the Action settings.
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White Balance Adjustment
Use the White Balance Action to adjust the white balance of your 
images. Pictures from cameras, either film or digital, might not 
come out the way you expect due to lighting. 

For example, in a white room with artificial light, you still 
perceive the walls as white. The camera, however, does not 
know if it is the walls that are yellow, for example, or the light. 
Unless your camera has white balance features, the image would 
most likely have yellow walls. Even with white balance 
adjustment features, the camera might not adjust correctly or 
fully.

This tutorial provides an example of adjusting white balance in 
an image so that what you perceive as white is displayed white.

1. Open snowman.jpg.

The snow in this picture has a blue tint, and the white 
balance adjustment can make the snow white.
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2. From the Actions menu, select White Balance... from the 
Correction category to open the White Balance Action 
Inspector.

3. Hold down the Control key and drag your mouse over parts 
of the image that should be white. TIFFany3 takes the 
average of the pixels that you drag over.

Tip For best results, drag over the brightest of areas that should be white, 
but not areas that are already white due to overexposure, for example 
the snow behind the two girls.
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4. The White Balance Action Inspector shows the average color 
that is used for the adjustment.

5. Press Apply in the toolbar.

TIFFany3 adjusts the white balance and makes the snow in 
the image white.
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Color Balance Adjustment
For some pictures, you do not want to adjust the overall 
saturation but only that of a specific color. For example, a picture 
can be too yellow, and you just need to balance the yellow 
channel of the image.

This tutorial provides an example of adjusting the color balance 
of an image.

1. Open BryceHooDoosFog.jpg.

Note that this picture is too blue and does not show the true 
color of the canyon.
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2. Select and apply the Less Blue Action (Color Balance > Less 
Blue).

3. Reapply the Action to further decrease the blue.

Now the picture is certainly less blue, but the canyon still has 
a sickly color.
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4. Select and apply the Less Cyan Action (Color Balance > Less 
Cyan).

The canyon now looks healthier, but it can use a dab of blush.

5. Select and apply the More Red Action (Color Balance > More 
Red).
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Horizon Alignment
Pictures are often taken with a slightly slanted horizon. This 
tutorial shows you how to easily use the Rotate and Crop tool to 
straighten the horizon.

Before you use the Rotate and Crop tool, you should check or 
specify the Resampling setting in the Bitmap Access preferences. 
The default is Two-lobed Lanczos, and the options are sorted by 
increasing resampling quality, from Box to Eight-lobed Lanczos. 

Use high quality resampling for best results from the Rotate and 
Crop tool, which automatically resamples the rotated layer. For 
more information about resampling, see Resampling Layers in 
the Caffeine Software TIFFany3 User Guide.
66     Caffeine Software TIFFany3 Tutorials



1. Open lake.jpg.

2. Open the Rotate and Crop tool by selecting Rotate and Crop... 
from the Tools menu.

3. Enter an angle to rotate the image by, for example, 359 or -1 to 
rotate the layer one degree to the right.

Note If the horizon was slanted the other way, you would enter 1 to rotate by 
a degree the other direction. Angles 1 through 179 rotates the layer to 
the left, and 359 through 181 to the right. Rotating by 180 just flips the 
image upside down without any cropping. You can also use negative 
degrees, for example -5 instead of 355.

4. Click Apply in the toolbar.
Horizon Alignment     67



The layer automatically rotates and crops according to the 
angle that you specify.

5. Because the horizon is still not straight, and you want to 
rotate by half a degree more, you can either:

• Enter 359.5 and click Apply

or

• Start over by undoing twice, once for the crop and 
another for the rotation, then enter 358.5 and click Apply. 
The final result has better quality if you start over.
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Cropping or Enlarging Layers by Ratio
Often the images that you want to print are not in standard sizes 
such as 5 by 7 or 16 by 20, and printing services might crop your 
images in unexpected and undesired ways. To avoid any 
surprises, you can use the numeric Crop tool to either crop or 
enlarge your image to fit a specified ratio.

This tutorial provides an example of cropping and enlarging a 
layer to a standard printing ratio. In general, you should try both 
options to see which way works better for your specific image.

1. Open shackSunset.jpg.

2. Open the numeric Crop tool by selecting Crop... from the 
Tools menu.

3. Select the Crop to aspect ratio option.
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4. Enter 16 : 20 with the Cut default.

5. Click Apply in the toolbar.

Cropping seems to cut too much of the image away, so you 
want to try enlarging.

6. Undo the crop.

7. Select Enlarge in the numeric Crop tool.

8. Click in the color well to open the color palette.
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9. Select a color, such as black, for the pixels to add to the 
image.

10. Click Apply in the toolbar.

By comparing the two results, you can decide, in this case, on 
the enlarged version.
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Paper or Background Removal
Use the Paper Removal Action to remove the background from 
your image, for example, the paper from an original scan. Some 
Actions work best or only with an image with a transparent 
background. If an Action is not producing expected results, it is 
possible that the Action should be applied to a layer with alpha, 
or transparency, if not a transparent background.

Note Paper Removal is available only in the Professional version of 
TIFFany3.

1. Open Letter-R.tiff. 
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2. Select Color Space in the Tools menu to check if your 
document has alpha (transparency) channels.

In the Color Space region, the selected option should end in 
Alpha. If not, select an option that does and apply the setting.

3. Select and apply the Paper Removal Action, which in this 
example removes the white paper from the watercolor paint 
and creates the appropriate alpha channel values.
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Note that in the areas where the watercolor only partially 
covers the paper, the alpha channel is now semitransparent.

4. Select and apply the Drop Shadow Action (Scripts > Drop 
Shadow). The Drop Shadow Action is one of a few Actions 
that make most sense when applied to an image with a 
transparent or semitransparent background.

Note The Drop Shadow Action is available only in the Professional version 
of TIFFany3. If you have the Basic version, try using some Actions in 
the Alpha Channel folder.
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Red Eye Reduction
Use the Red Eye Action to remove red eyes from your image. 
Though this Action was designed specifically for this purpose 
and alone can fix most red eyes, you can also use the Less Red 
Action in addition in particular cases. 

This tutorial provides an example of applying the Red Eye and 
Less Red Actions to the eyes in an image for red eye reduction.

Note This Red Eye Action is available only in the Professional version of 
TIFFany3. If you have only the Basic version, try using the Less Red 
Action by itself.

1. Open jacket.jpg.
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2. Zoom in to the eyes.

3. Create a freehand marquee around one eye.

4. Select and apply the Red Eye Action (Scripts > Red Eye).
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5. Create a freehand marquee around the other eye and make 
sure that the other marquee is hidden or deleted.

6. Apply the Red Eye Action again.
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7. You can reapply the Action to further reduce the red in the 
eye.

8. The pink glare in this eye is particularly tricky. Create 
another freehand marquee around the glare.
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9. Select and apply the Less Red Action (Color Balance > Less 
Red) twice.

The image is now rid of the red eyes.
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Retouching Images
Use the Cloning Action to retouch your images. For example, to 
remove people or cars from the background, you can clone 
another part of the image to brush over the unwanted elements. 
These tutorials provide examples of using the Clone Action to 
touch up pictures.

Removing Dust Trace

This image has a dust trace in the upper left part of the sky that 
you want to remove.

1. Open Sydney.jpg.
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2. Select the Zoom tool and click near the dust trace.

3. Select the Cloning Action (Cloning > Cloning) and open the 
Action Inspector by clicking Settings in the toolbar.

4. If the setting is not Fixed Origin, select the Fixed Origin 
option and save the Action.

5. Select the Brush tool.

6. Open the Brush Inspector with Command+8. You can also 
select Inspector... from the Controls menu and then select 
Brush from the poplist in the Inspector.
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7. Increase the Smooth setting to 4 so that the edges of the brush 
strokes fade out by 4 points.

8. Control-click with the brush near the dust trace, wherever 
you want to base the cloning on. The Fixed Origin setting 
means that you clone at the origin of the Control-click.
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9. Brush over the dust trace in one single brushstroke. The 
beginning of the brushstroke clones the Control-clicked 
origin, and the rest of the brushstroke traces the area with 
respect to the origin.

10. If necessary, brush over the dust trace another time and touch 
up areas that stand out from the rest of the sky.

The image now has a perfect sky, with the dust trace 
successfully removed.
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Removing Background Object

This picture has a car in the background that you want to 
remove.

1. Open Boat.jpg.

2. Select the Cloning Action (Cloning > Cloning) and open the 
Action Inspector by clicking Settings in the toolbar.

 Note The Action is by default set with the Fixed Offset option.
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3. Zoom in on the car and Control-click with the brush to set the 
origin for the cloning.

4. With your first click after the Control-click, you clone the 
origin with your brush. 
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5. With subsequent clicks or brush strokes, using the Fixed 
Offset option from the Action setting, you clone the area 
offset according to the origin. For example, if you click 
directly to the right of your first click, you clone the area 
directly to the right of the origin.

If you then click to the left of your first click, you clone the 
area left of the origin.

6. You can keep cloning with the same origin or Control-click 
somewhere else to use another origin. 
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7. Brush over the car some more with the new origin offset.

8. Back in the Action settings, choose the Fixed Origin option 
and click Save in the toolbar.

Note You can only brush with Action settings that are saved in the Action 
Catalogue.

9. Open the Brush Inspector with Command+8. You can also 
select Inspector... from the Controls menu and then select 
Brush from the poplist in the Inspector.
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10. Increase the Smooth setting to 5 so that the edges of the brush 
strokes fade out by 5 points.

11. Control-click again on the document to set the origin. 

With the Fixed Origin offset, every time you click on the 
document, you start over cloning the origin. With the Fixed 
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Offset, every time you click on the document, you clone the 
area correspondingly offset by the origin. 

12. Zoom in even more and use a smaller brush to finish 
retouching the car with either cloning option. Remember to 
save the Action when you switch to another option. 
Otherwise, even though the other option is selected, you 
would still brush with the setting that was last saved with the 
Action.
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13. Your final result is an image with the car removed from the 
background.
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Rotating Parts of the Image
You can brush or use a marquee with a Rotate Action to rotate 
only certain areas of your image. For example, you have a 
picture of a car in profile, and you want the top spoke of the 
wheel rim to be vertical. This tutorial demonstrates how you can 
manually apply a Rotate Action to achieve your goal. 

1. Open wheel.jpg.

2. Create an elliptical marquee around the rim. 
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3. To make sure that the marquee is a perfect circle, open the 
Marquee Inspector with Command+3. You can also select 
Inspector... from the Controls menu and then select Marquee 
from the poplist in the Inspector.

4. Make sure that the width and height of the marquee are the 
same.

Tip Press the Reset button in the Marquee Inspector to change any 
elliptical marquee into a perfect circle.

5. Select a Rotate Action (Geometry > Rotate) and open the 
Action Inspector. 

6. If you do not see expert settings, click Expert in the toolbar of 
the Action Inspector.

7. Estimate and enter the angle of rotation. 
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8. Check that the Gradient bounds option is set to Marquee and 
leave the Origin setting with the default 50% for both 
coordinates. This way, you ensure that the origin of rotation 
is the center of the elliptical marquee.

9. Click Apply in the Action Inspector toolbar.
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10. You notice that the top spoke is not yet vertical. Reapply the 
Action with as many angle adjustments until you are 
satisfied.

The rim is now rotated appropriately so that the top spoke is 
vertical. 
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Perspective Modification
Use a Four Point Mapping Action to change the perspective in 
an image. This tutorial provides an example of changing the 
perspective of a building so that it looks as if you are looking at 
the building straight on, instead of from the bottom.

Note Four Point Mapping is available only in the Professional version of 
TIFFany3.

1. Open building.tiff.
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2. From the Actions menu, select Four Point Mapping from the 
Geometry Action category. The Action Inspector appears.

Note The Four Point Mapping family does not have a preconfigured Action 
in the Action Catalogue because you use different settings for each 
individual document.

3. Imagine the side of the building as a slanted rectangle that 
you want to straighten out. Control-click twice in one corner 
of that rectangle. You are setting the first source and 
destination point. 

In this case the source and destination points are the same 
because you are not moving the building, just changing the 
perspective.
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4. Control-click in the other corners of your imaginary rectangle 
to set the other three pairs of source and destination points. 
The order that you set the points in does not matter.

5. Press the Force Destination Rectangular button in the Action 
settings window.

The destination points automatically adjust to form a 
rectangle.
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6. Click Apply in the toolbar. The Action modifies your image, 
mapping the source points of the slanted rectangle to the 
destination points of the perfect rectangle.
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Adding Text to the Image
Use the text marquee to add text to your document. Remember 
that when you apply an Action to the marquee to create text, the 
text becomes part of the layer just like results of other Action 
applications. Do not delete the text marquee, or any marquee, 
unless you are sure that you do not need it anymore.

This tutorial provides an example of using text marquees to add 
text to your document.

1. Open Cockatoos.tiff. 

2. Select the Text Marquee tool and click in the document where 
you want the text. The text panel appears.

3. Open the font panel by pressing Command+T or pressing the 
font panel button.

4. In the font panel, select the font family, type, and size.
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5. Back in the text panel, type in the text that you want.

6. With the Arrow or Rotate tool, you can resize, shape, move, 
or rotate the text marquee. 

Note To edit the text marquee, double-click within the marquee borders to 
bring up the font panel.
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7. Select and apply the Twine Action (Texture > Mandelbrot > 
Twine).

8. Use the Magic Wand tool to create a bitmap marquee that sets 
off the sky. 

9. Open the Marquee Inspector with Command+3. You can also 
select Inspector... from the Controls menu and then select 
Marquee from the poplist in the Inspector.

10. In the Marquee Inspector, set the Type option for the bitmap 
marquee to Difference.

11. To select the text marquee, the easiest way is to use the 
Components Inspector (Command+1 or use the Inspector 
poplist). Click on the X to unhide the text marquee 
component, if necessary.
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12. Go back to the Marquee Inspector and set the Type option for 
the text marquee to Difference also. 

13. Select and apply the Invert Action (Color Map > Invert). The 
Action is applied to the birds only, or the areas outside the 
bitmap and text marquee.

14. Go back to the Components Inspector and click on the check 
next to the bitmap marquee to hide just that component in 
the document. 

15. Select the text marquee and change its Type setting back to 
Union. 

16. Select and apply the Marquee Bezel Action (Scripts > 
Marquee Bezel), which is only applied within the active text 
marquee.
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Note Marquee Bezel is available only in the Professional version of 
TIFFany3. If you have the Basic version, select another Action to use.

The final result is an example of using the text marquee to add 
text to your image.
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Creating and Deleting Actions
An Action is a preconfigured collection of settings that you 
apply to your document, and each Action belongs to an Action 
family and category. For example, the Control Action category 
includes the Saturation Action family, and TIFFany3 provides 
preconfigured Saturation +20% and Saturation -20% Actions. 
You can create more Saturation Actions, such as Saturation 
+10%, for additional saturation adjustments that you frequently 
use.

This tutorial provides an example of creating and deleting an 
Action, Saturation +10%.

Creating New Actions

1. In the Action Catalogue, select the folder, Color Balance, 
where you want to place the new Action. You can always 
move the new Action later to another folder.

2. Click New Action in the toolbar of the Action Catalogue. An 
untitled Action appears at the bottom of the existing list of 
Actions in the selected folder.

3. Select Control, the Action category that the new Action 
belongs to.
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4. Select and double-click on Saturation, the Action family that 
you want to create a new Action for.

5. The Action Inspector for the Action family appears with the 
Action settings. Set the saturation to +10% and save the 
Action.

6. In the Action Catalogue, with the untitled Action selected, 
enter Saturation +10% in the field next to the Action icon and 
press Return.

Your new Action is now ready for use.
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Deleting Actions

1. Select the Saturation +10% Action in the Action Catalogue 
browser.

2. Click Delete in the toolbar of the Action Catalogue.

3. If you decide that you want the Action back, go to the 
Controls menu and select Show Deleted Items from the 
Action Catalogue menu option.

4. The Deleted Items folder appears in the Action Catalogue, 
containing any items such as Actions and folders that were 
deleted from the Action Catalogue since you installed the 
application. 

Note If you later delete an item with a name that exactly matches the name of 
something in the Deleted Items folder, the latest deleted item overrides 
the original.

5. You can apply the Action from here, but most likely you 
would want to move it to an appropriate folder. 

6. To permanently remove something from the Action 
Catalogue, select the entity in the Deleted Items folder and 
click Delete.
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Creating Process Actions

A Process Action consists of a series of Actions to be applied to 
your image. 

Note Process Actions are available only in the Professional version of 
TIFFany3.

Some preconfigured Process Actions include the Drop Shadow 
and Oil Painting Actions. The Drop Shadow Action, for example, 
starts with the Offset 10pt SE Action which offsets the image. 
The Black Action with 50% opacity and the Gaussian 09 Action 
changes the offset image into a shadow. The shadow is then 
combined with the original image using an Under compositing 
setting, as the gray arrow from the source to the Gaussian Action 
signifies. The combined image is the end result: the original 
image with a shadow.

Process Actions are not just useful for complex processes but 
also for applying multiple Actions at once. For example, it is 
difficult to manually apply a Contrast and then a Sharpen Action 
to exactly the same areas of a model’s face. You can create a 
single Process Action to use for this purpose.

You can use Process Actions like any other Action and even 
include Process Actions within other Process Actions.
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This tutorial provides an example of how to create a Bezel Action 
that highlights the image on the right side and gives it a small 
shadow on the other.

Original Image

With Bezel Action Applied
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1. Click New Action in the Action Catalogue toolbar, select the 
Customize Action category, and select and double-click on 
the Process Action family. The Process Action Inspector 
appears.

2. First, to create the highlight, drag an Offset Action (Geometry 
> Offset) to the canvas and double-click on it to open the 
Action settings. Change the horizontal offset to 2.0 and the 
vertical offset to 2.0, and save the Action. 

Note You modify just the Action that you copied to the canvas. The original 
Offset Action is not affected.

3. Drag the White Action (Paint > Colors > White), place it 
below the Offset Action, and open the Action settings. Set the 
compositing to In because the Action should apply only 
within the area that was offset. 

Tip If you do not see the compositing controls, click Expert in the toolbar.
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4. Create black arrows to designate the primary process flow. 
Control-click on the Source and drag an arrow to the Offset 
Action. Control-click on the Offset Action and drag an arrow 
to the White Action. 

5. To create the shadow, you need another pipeline. Drag an 
Offset Action (Geometry > Offset) into another column with 
the horizontal offset at -2.0 and vertical offset at -2.0.
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6. Place the Black Action (Paint > Colors > Black) underneath, 
with the In compositing setting, and connect this pipeline 
with arrows.

7. Place the Identity Action (Temp > Identity) between the two 
pipelines. The Identity Action is used only within Process 
Actions for compositing purposes. In this case, you want to 
combine the two pipelines, with the white offset either above 
or under black offset.
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8. Drag a black arrow from either the White Action to the 
Identity Action. As you have been doing, a black arrow is 
created when you drag into the top of the destination icon. 
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9. Drag an arrow from the Black Action into the side of the 
Identity Action icon to create a gray arrow. Gray arrows are 
used only for compositing. 

10. Open the settings for the Identity Action and set the 
compositing to Over or Under. In this case, it does not matter 
between these two settings because the original image will be 
placed on top of the two offset areas.
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11. Now you need to combine the black and white offsets with 
the original image. Drag another Identity Action to the 
canvas and connect it with the Source. 

12. Drag a gray arrow to connect the Identity Actions. 
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13. Open the settings for the second Identity Action. In this case, 
you need to set the compositing to Over. The original image 
needs to be on top of the combined black and white offsets, 
and the black arrow signifies the primary process, so the 
compositing is with relation to the Source.

14. Drag a final black arrow from the second Identity Action to 
the Result. 

Your Process Action is complete, and the end result is a Bezel 
Action with the original image on top of the black and white 
offsets.

15. Save the Process Action and name it in the Action Catalogue. 

16. Open Letter-R.tiff and apply the Action.

Note This Bezel Action works only with documents that have alpha, or 
transparency. The Action work best with images surrounded by 
transparent pixels, for example Letter-R.tiff.
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Merging Images - Process Action Example

Not only can you combine multiple layers into one, you can also 
create a Process Action that you can brush with to merge one 
image into another layer. This tutorial provides an example of 
creating a Process Action that you can use to merge elements of 
one layer on top of another. 

Note Process Actions are available only in the Professional version of 
TIFFany3.

1. Open Cockatoos.jpg and Sheep.jpg.

In this example, you want to merge the birds into the image 
of the sheep.

2. Create a new Process Action.

3. Drag the Image PB Action (Paint > Image PB) to the Process 
Action canvas. The Image PB Action takes a file or the image 
on the pasteboard and applies that image as an Action. The 
preconfigured Image PB Action takes the image from the 
pasteboard, in this case, that would be the birds.

4. Drag a black arrow from the Source to the Image PB Action.

5. Drag the Paper Removal Action (Alpha Channel > Paper 
Removal) to the Process Action canvas, open the color 
palette, and open the Action Inspector by double-clicking on 
the Action in the canvas.
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6. Capture the color of the sky in the palette to set the 
background color that is to be removed with the Paper 
Removal Action.

Tip You can also Control-click with any tool over the layer to capture the 
color of the click point in the color palette.

7. Set the Color Removal Limit control in the Action Inspector 
to 10% to establish a tolerance for the paper removal, to make 
sure that the entire sky is removed.

8. Save the Paper Removal Action.

9. Drag a black arrow in the Process Action canvas to connect 
the Image PB Action to the Paper Removal Action. The Paper 
Removal Action will be applied to the image on the 
pasteboard.

10. Drag a gray arrow from the source to the Paper Removal 
Action to combine the birds with the background removed 
with the source image, or the sheep. 

11. Open the Action Inspector for the Paper Removal again and 
set the Compositing control to Over because you want the 
birds above the sheep.

12. Save the Paper Removal Action.
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13. Drag a black arrow from the Paper Removal Action to the 
Result and save the Process Action.

14. Rename the Process Action in the Action Catalogue, for 
example, Merge.

15. Select the copy birds layer so to place the image on the 
pasteboard.

16. In the sheep layer, you can brush the Merge Action to apply 
certain birds above the sheep.
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17. You can alternatively click Apply in the Action Catalogue 
toolbar to merge all birds into the sheep layer.
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Extending Dynamic Range by Merging Bracketed 
Exposures

Many photographers bracket exposures so that they can select 
the best exposed version of the same image. For example, you 
set up the camera to take three exposures: under exposed, 
correctly exposed, and over exposed.

With the Dynamic Range tool, you can merge bracketed 
exposures so that you not only get the best exposure, but also 
greater detail in the highlights and shadows, thus extending the 
dynamic range of the correctly exposed version. Out of three 
exposures of the same image, the Dynamic Range tool creates a 
new TIFFany3 document that is well-saturated and balanced in 
contrast.

The Dynamic Range tool works only for images that are exactly 
the same except for the exposure, as shown above. To take such 
pictures, the subject should be stationary and you must use a 
tripod. Cable release and mirror pre-lock are highly 
recommended, as well as using Aperture Priority with the same 
aperture while varying the exposure time.

Note The Dynamic Range tool is available only in the Professional version of 
TIFFany3.

This tutorial shows you how to use the Dynamic Range tool to 
extend the dynamic range of images.

1. Open the Dynamic Range tool.

2. Leave the Bracketing set at Under-Correct-Over.

3. Select IMG_6730.jpg, IMG_6731.jpg, and IMG_6732.jpg in 
Caffeine Software Curator or Finder and drag all three at the 
same time into any part of the Dynamic Range tool outside 
the text fields.

For more information about Curator, see the Caffeine Software 
Curator User Guide.
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The three documents default correctly into the text fields 
because they sequentially correspond to the Bracketing 
setting of Under-Correct-Over.

IMG_6730.jpg, the first document in the bracketed sequence, 
is the under-exposed image:
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IMG_6731.jpg, the second document, is the correctly-exposed 
image:

Finally, IMG_6732.jpg is the over-exposed version:

Note Set the Bracketing control to correspond to the way your camera 
sequentially brackets, Under-Correct-Over or Correct-Under-Over. 
Alternatively, you can also drag specific documents from Curator or 
Finder into the appropriate text fields.
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4. Accept the flatten default if you want the new document to 
have one layer, or uncheck the Flatten When Done check box 
if you want the new document to consist of three layers.

5. Click Run in the toolbar.

The Dynamic Range tool runs and the new document, 
IMG_6731-C.jpg appears. The default name of this document 
is the name of the correctly-exposed document with -C 
appended.

Compare the new document to the original correctly exposed 
image. You can see the difference in the details if the highlights 
and shadows, as well as the color, saturation, and overall look.
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Setting Up and Running Batch Processes
A powerful feature available only in TIFFany3 Professional 
version is document batch processing. You use the Document 
Manager window to set up a list of documents and the Actions 
that you want to apply to them. This tutorial provides an 
example of creating and running a batch process.

1. Open the Document Manager window.

2. Drag image documents that you want to batch process into 
the browser. 

3. Drag a folder into the browser. All documents within that 
folder are added to the list, including documents in any 
subfolders. 

4. To set up a Contrast Action that you want to apply to all 
documents, first select all the documents in the Document 
Manager window. 

5. Select the Contrast + 20% Action (Brightness > Contrast 
+20%) and click Apply in the Action Catalogue toolbar. The 
Action is not actually applied yet, but set up in the batch 
process. The Document Manager window lists the total 
number of documents in the batch and the total number of 
Actions set up.
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6. Now when you select any document in the Document 
Manager window, you see the Action listed in the Action 
column.

7. To set up a Gaussian Action to apply to certain documents, 
first select those documents in the Document Manager 
window. 

8. Select the Gaussian 05 Action (Sharp > Gaussian 05) and click 
Apply in the Action Catalogue toolbar. Now that Action is set 
up to be applied after the Contrast Action for the documents 
that you specified.

9. To apply the series of Actions set up for one document, select 
that document and click Start Batch in the toolbar. 

10. Specify the output format and the settings for that format. 

11. Keep the output file in the current directory, the directory of 
the original document. 
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12. If you are saving the file in the same format as the original 
and do not want to keep a backup, uncheck the Keep Backup 
check box.

13. Press the Execute button. The Actions set up for this 
document are applied and the original file is replaced by the 
new. The document name is also removed from the 
Document Manager browser.

14. In the Document Manager, to remove an Action or document 
from the browser, you can just select the item and delete it. 
You can still add documents and Actions at any point.

15. To run a batch process of all the documents, select all of them 
and click Start Batch.

16. Specify the output format and the settings for that format.
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17. To put the modified images into a directory different from 
that of the original documents, set the destination directory. 

18. In case the originals of some documents reside in the 
destination directory that you specified and you are saving 
the modified files in the same format, make sure the Keep 
Backup check box is checked if you want to keep a backup of 
the original.

19. Press the Execute button. A batch process runs to apply the 
series of Actions that you set up for each document in the 
Document Manager window.

Tip While a batch is processing, you can still select all or some documents 
in the Document Manager window and press Delete to remove those 
documents from the batch process
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